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Milli Eğitim Bakanlığı tarafından geliştirilen modüller;

 Talim ve Terbiye Kurulu Başkanlığının 02.06.2006 tarih ve 269 sayılı Kararı ile
onaylanan, Mesleki ve Teknik Eğitim Okul ve Kurumlarında kademeli olarak
yaygınlaştırılan 42 alan ve 192 dala ait çerçeve öğretim programlarında
amaçlanan mesleki yeterlikleri kazandırmaya yönelik geliştirilmiş öğretim
materyalleridir (Ders Notlarıdır).

 Modüller, bireylere mesleki yeterlik kazandırmak ve bireysel öğrenmeye
rehberlik etmek amacıyla öğrenme materyali olarak hazırlanmış, denenmek ve
geliştirilmek üzere Mesleki ve Teknik Eğitim Okul ve Kurumlarında
uygulanmaya başlanmıştır.

 Modüller teknolojik gelişmelere paralel olarak, amaçlanan yeterliği
kazandırmak koşulu ile eğitim öğretim sırasında geliştirilebilir ve yapılması
önerilen değişiklikler Bakanlıkta ilgili birime bildirilir.

 Örgün ve yaygın eğitim kurumları, işletmeler ve kendi kendine mesleki yeterlik
kazanmak isteyen bireyler modüllere internet üzerinden ulaşabilirler.

 Basılmış modüller, eğitim kurumlarında öğrencilere ücretsiz olarak dağıtılır.

 Modüller hiçbir şekilde ticari amaçla kullanılamaz ve ücret karşılığında
satılamaz.
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ALAN İnşaat Teknolojisi Alanı

DAL/MESLEK İç Mekân Teknik Ressamlığı
MODÜLÜN ADI Bilgisayarla Üç Boyutlu Çizim

MODÜLÜN TANIMI
Temel 3 Boyutlu çizim komutlarını kullanmakla ilgili

temel bilgi ve becerilerin kazandırıldığı öğrenme
materyalidir.

SÜRE 40/32

ÖN KOŞUL İki Boyutlu Çizim modüllerini başarmış olmak.

YETERLİK Bilgisayarla üç boyutlu çizim yapmak.

MODÜLÜN AMACI

Genel Amaç:
Okul içi gerekli ortam, okul dışı araştırma

yapılabilecek işletmeler, kütüphaneler belirtildiğinde
bilgisayarla üç boyutlu çizimlerini standartlara uygun
yapabileceksiniz.
Amaçlar:
 3 boyutlu koordinat sistemlerini kullanabileceksiniz.
 3 boyutlu görüş pencerelerini kullanabilecek ve

etkileşimli izlemeler yapabileceksiniz.
 3 boyutlu model gölgelendirmeler yapabileceksiniz.
 3 boyutlu çizgiler çalışabilecek ve filtreleri

kullanabileceksiniz.
 3 boyutlu yüzey kaplama çalışmaları yapabileceksiniz.

EĞİTİM ÖĞRETİM
ORTAMLARI VE
DONANIMLARI

Bilgisayarla üç boyutlu çizim için gerekli ortamlar
(uygulamaya yönelik bilgisayar donanımı ve yazılımı) ile
araç ve gereçler sağlanmalı, araştırma yapılacak web,
kütüphane, işletmeler için yol gösterilmeli, teorik ve
uygulamalı olarak yapılmalıdır.

ÖLÇME VE
DEĞERLENDİRME

Her faaliyet sonrasında o faaliyetle ilgili değerlendirme
soruları ile kendi kendinizi değerlendireceksiniz.

Öğretmen, modül sonunda size ölçme aracı (uygulama,
soru-cevap) uygulayarak modül uygulamaları ile
kazandığınız bilgi ve becerileri ölçerek değerlendirecektir.

AÇIKLAMALAR
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GİRİŞ
Sevgili Öğrenci,

Bu modül sonunda edineceğiniz bilgi ve beceriler ile bilgisayar ortamında 3 boyutlu
düşünmeyi ve bu düşüncenizi gerçekleştirmek için vazgeçilmez olan bilgisayarla 3 boyutlu
çizim için temel bilgi ve becerileri edineceksiniz.

Bildiğiniz üzere teknolojinin her geçen gün hızla ilerlediği zamanımızda, bilgisayar ve
uygulamalarını kullanmak kaçınılmaz olmuştur. Her alanda olduğu gibi 3 boyutlu tasarım /
modelleme ve oluşturulan bu modelleri görselleştirme işlemlerinde de bilgisayar
kullanılmaktadır. Bilgisayar ortamında 3B tasarım / modelleme, uygulamalarınızda büyük
hız, zaman tasarrufu, doğruluk ve ekonomi sağlamaktadır.

Bilgisayar ortamında 3B (3 boyutlu) olarak tasarlanmış bir binanın bütün görünüşleri,
kesitleri, perspektifleri ve hatta binanın bitmiş resimleri bu tasarıdan elde edilebilir. Bu size
proje ve fikirlerinizi kolayca anlatma / sunma benimsetme olanağı verir.

3B tasarım sadece bina ile sınırlı değildir. Daha birçok alanda bunu kullanmak
olanaklıdır. Bir bakıma sınır sadece sizin proje ve fikirlerinizdedir. Ancak şunu da
belirtmekte yarar var; bilgisayar ve uygulama programları sadece bizim fikir ve projelerimizi
gerçekleştirmede çok hızlı olan araçlardır. Hiçbir bilgisayar, siz ve fikirleriniz olmadan kendi
başına bir proje üretemez.

Yukarıda anlatılanları gerçekleştirmek için, 3 boyutlu çizime temel olacak bütün
sorularınızın cevabını bu kitapçıkta bulabileceksiniz.

Bir binanın 3B modeli

GİRİŞ
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3

ENME FAALİYETİ - 1

Uygun ortam sağlandığında üç boyutlu koordinat sistemini tanıyıp yeni koordinat
düzlemleri oluşturacak ve basit bir tel çerçeve yapabileceksiniz.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır:

 Teknik resim ve tasarı geometri kitaplarından epür, izdüşüm ve koordinat

sistemlerini araştırınız.

 Bilgisayarlı çizim programlarında bir doğru parçasının özelliklerini araştırınız.

Araştırma işlemleri için teknik resim ve tasarı geometri dersi kitapları, internet ortamı,
değişik bilgisayarlı çizim programları gerekmektedir. Bilgisayarlı çizim yapan işletmelerden
de ön bilgiler alabilirsiniz.

1. 3 BOYUTLU (3B) KOORDİNAT SİSTEMİ

1.1. WCS ve UCS Koordinat Sistemleri

3B çizimlerde de her bilim dalında olduğu gibi kendine özgü bir takım terimler vardır.
Aşağıda bunlarla ilgili kısa bilgiler sunulmuştur.

1.1.1. Üç Boyut - 3B (İngilizce: 3 Dimension -3D)

Çevremizde gördüğümüz her şey; masa, sandalye, bilgisayar vb. üç boyutludur. Yani
her bir nesne, bir oda vb. bir boşluk içinde genişliği, yüksekliği ve derinliği olan bir yapıya
sahiptir. Gözümüz tıpkı kameralar, fotoğraf makineleri gibi bu nesneleri bir düzlemdeki iki
boyutlu resim gibi görür. Ancak gözlerimiz ve beynimizin yapısı ve çalışma sistemi
sayesinde biz bütün dünyayı 3 boyutlu algılarız. Bir fotoğraf (ya da kâğıda çizilmiş
perspektif resim) iki boyutludur ancak biz bunu 3 boyutlu algılarız. Aslında bilgisayar ekranı
(tıpkı TV gibi) da iki boyutlu bir düzlem olup ekran üzerindeki bütün görsel öğeler de iki
boyutludur. Dolayısıyla bilgisayarda sayısal olarak üretilmiş 3 boyutlu nesnelerin görüntüleri
de iki boyutludur. Ancak biz 3B modellenmiş nesneleri de tıpkı gerçek ortamdaki gibi 3B
algılarız. Bu da bize bir projeyi, bir fikri gerçek ortamdaymış gibi oluşturma ve sunma
olanağı verir.

ÖĞRENME FAALİYETİ–1

ARAŞTIRMA

AMAÇ
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1.2. Üç Boyutlu (3B) Uzay

Bilindiği üzere uzay; sınırları belli olmayan sonsuz boşluk olarak tanımlanır.
Gözümüzle gördüğümüz algıladığımız her nesne bu uzay içerisinde yer alır. Orijin
noktasında, her biri diğer iki eksen doğrultusuna dik, x, y ve z eksenlerinden oluşan sanal
uzay boşluğudur. Bilgisayarda çizim yapılırken genellikle aşağıda Şekil 1.1’de görülen sağ
tarafta belirtilen alan kullanılır.

Tasarım / modelleme yapılırken bu eksenlerden ikisinin oluşturduğu düzlemlerden biri
kullanılır. Bu düzlem genellikle XY düzlemidir.

Şekil 1.1: Üç boyutlu uzay

1.1.3. Orijin

X, Y ve Z eksenlerinin üçünün bir noktada kesiştiği yerdir. Koordinatlar belirlenirken
bu nokta esas alınır. Bu noktadan X ekseni sağa doğru + (pozitif), sola doğru – (negatif)
değer alır. Yine bu noktadan Y ekseni yukarı + (pozitif), aşağı doğru – (negatif) değer alır.
Bu noktadan Z ekseni (ekrandan size doğru) XY düzleminden yukarı + (pozitif), aşağı doğru
ise – (negatif) değer alır. Yukarıda Şekil 1.1’de eksenler ve yön değerleri verilmiştir.

1.1.4. Koordinat ve Koordinat Sistemleri

Öğretmeniniz sınıfınızdan kalem getirmenizi isterse, sınıf içinde kalemin yerini
bilmediğinizden kalemin yerini sorarsınız. Masasının üstünde vb. cevap size kalemin yeri ve
konumunu belirtir. Uzaydaki bütün nesnelerin noktalarının da yeri ve konumu vardır.

Koordinat, üç boyutlu uzay ortamında bir noktanın konumunu belirler. X, Y ve Z gibi
üç eksene göre noktanın konumunu ifade eder. Bu genellikle orijine göre tanımlanır. Aşağıda
Şekil 1.2’de X, Y ve Z eksenleri ve yönleri verilmiştir. Şekil 1.3’te bir kutu modeli ve bu
modeli oluşturan koordinatlar görülmektedir. A noktasının koordinatları şekilde görüldüğü
gibi, X= 80, Y=30, Z=40’dır. A(80,30,40) şeklinde de yazılabilir. B noktasının koordinatları
ise B(80,70,30) şeklindedir. Diğer noktaların koordinatlarını da Şekil 1.3’ü inceleyerek siz
bulunuz.
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Şekil 1.2: Koordinat eksenleri ve yönleri

Şekil 1.3: Bir kutunun koordinatları

Koordinat sistemi temel olarak iki şekilde yer alır:
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Bunlardan ilki mutlak koordinatı tanımlayan WCS (World Coordinate System) ile
tanımlanan mutlak koordinat sistemidir. İkincisi ise UCS (User Coordinate System) ile
tanımlanan kullanıcı koordinat sistemidir.

1.1.4.1. Dünya / Mutlak Koordinat Sistemi - WCS

Bu koordinat sistemi mutlak / dünya koordinat sistemi olarak da bilinir. Yer
düzlemine paralel olduğu varsayılır. Varsayılan olarak bütün çizimler, bu koordinat
sistemine göre olan XY düzlemindeki iz düşümlerdir. Hatta iki boyutlu çizimlerde her zaman
bu koordinat sistemi kullanılabilir. Yani siz herhangi bir değişiklikte bulunmazsanız,
çizimleriniz WCS koordinat sisteminde, XY düzleminin tam üstünde çizilmiş olur

1.1.4.2. Kullanıcı Koordinat Sistemi - UCS

WCS bazı durumlarda yetersiz kalır. Şöyle ki, bir binanın duvar düşey yüzeyi üzerinde
çalışmak istiyorsunuz. WCS size sadece yatay düzlem üzerinde çalışma olanağı
tanıdığından, söz konusu duvar için yeni bir düzlem oluşturmak gerekir. UCS bize bu
olanağı sağlar. WCS bir adet olmasına rağmen, UCS’de sınırlama yoktur.

UCS komutu çalıştırıldığında aşağıdaki işlemler yapılabilir.

Command: UCS  (Enter)

Enteran option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]

<World>:

New: Yeni UCS tanımlamanızı sağlar. Aşağıda açıklanan alt seçenekleri vardır.

Move: Orijini başka bir konuma taşır.

orthoGraphic: UCS’yi ana görünüş düzlemlerine paralel hale getirir.

Prev: Bir önceki UCS’yi aktifleştirir.

Restore: Kaydedilmiş UCS’yi aktif kılar.

Save: Konumu belirlenmiş UCS’yi bir isim altında kaydeder. Eğer oluşturulan UCS
daha sonra kullanılacak ise mutlaka kaydedilmelidir.

Del: Kaydedilmiş UCS’lerden istenileni siler.

Apply: Görünüm pencerelerine UCS’nin uygulanmasını sağlar.

World: UCS’den çıkılarak WCS’ye dönülmesini sağlar.

Yukarıdaki iletide New (N enter yeterli) girildiğinde aşağıdaki yeni ileti ekrana gelir:
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Specify origin of new UCS or [ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>:

ZAxis: Yeni UCS’nin Z pozitif yönünü belirler.

3point: 3 noktaya göre yeni UCS oluşturur.

OBject: Bir nesnenin konumundan faydalanılarak yeni UCS oluşturur.

Face: 3B çizilmiş nesnelerin yüzeylerini kullanarak UCS oluşturulmasını sağlar.

View: Ekran görüntüsü XY düzlemi olmak üzere, UCS’yi buna göre hizalar.

X/Y/Z: UCS’nin seçilen eksen etrafında belirlenen açı ile döndürülmesini sağlar.

UCS ile ilgili olan komutlara üst mönüde > Tools altında yer alan ilgili seçimler
yapılarak ulaşılabilir. Aynı zamanda Şekil 1.4’teki araç çubuklarını kullanarak da bu
komutlara ulaşmak mümkündür.

Şekil 1.4: UCS araç çubuğu

1.1.5. Farklı UCS İkonları

UCS ikonunu bazen kontrol etmek veya görünümünü değiştirmek gerekebilir. Bunun
için UCSICON komutu kullanılır. Komut çalıştırıldığında aşağıdaki iletiler ekrana gelir.

Command: UCSICON  (Enter)

Enter an option [ON/OFF/All/Noorigin/ORigin/Properties] <ON>:

ON/OFF: Koordinat ikonunun görünür olup (ON) / olmamasını (OFF) sağlar.

All: Koordinat ikonu seçeneklerinin bütün pencerelere uygulanmasını sağlar.

Noorigin / ORigin : Koordinat ikonunun orijin noktasında (OR) veya dışında (No)
gösterilmesi sağlar.

Properties: Ekrana gelecek diyalog kutusu ile ikonun büyüklük, renk ve görünümü ile
ilgili seçenekleri düzenler.
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Şekil 1.5: UCS ikonu diyalog kutusu

Aşağıda Şekil 1.6 (e ve d)’ da WCS koordinat sisteminin sembolü gösterilmiştir. Diğer
semboller perspektif görünüşlerde görülür. Kırık kalem şeklindeki ikon ise aktif UCS veya
WCS’ye göre paralel bakış doğrultularında görünüş elde edildiğinde görüntülenir.

a) b) c)

3 Boyutlu görüntülemede UCS sembolleri.

d) e) f)

Plan düzlemde UCS sembolleri.

Şekil 1.6: WCS ve UCS ikonu görünümleri
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Dosyanızda katman, limits vb. gerekli
hazırlıkları yapınız.

 Şekil 1.7’deki dikdörtgen prizmanın
75*50 cm’lik tabanını çiziniz.

 Prizma tabanını 30 cm Z eksenine doğru
kopyalayınız.

 Line komutu ile prizmanın düşey
çizgilerini çiziniz.

 UCS komutunu çalıştırınız.

 New seçimi yapınız.

 3 Point seçimi yapınız.

 UCS’nin orijini olarak prizmanın ön – sol
– alt tarafını seçiniz.

 X pozitif yönü olarak ön - sağ – alt köşe
noktasını seçiniz.

 Y pozitif yönü olarak ön - sol – üst köşe
noktasını seçiniz.

 Tekrar UCS komutunu giriniz.

 Save seçimi yapınız

 Ön-görünüş vb. gibi adla UCS’yi
kaydediniz.

 Gerektiğinde aynı UCS’yi aktif kılmak
için, UCS komutundan sonra [Restore]
seçimi yapın ve kaydettiğiniz ismi giriniz.

 Şeklin yazılarını tamamlayınız.

 Bu işlemleri yaparken komut satırını
kullanmayı tercih ediniz.

 Gerektiğinde OSNAP modlarını
kullanınız.

 Z ekseni doğrultusunda kopyalama için
@x,y,z gibi relatif koordinat
kullanabilirsiniz.

 Komut alt seçeneklerini seçerken, New
(N), 3 Point (3) vb. kısa tuşlarını tercih
ediniz.

 Katman kullanmayı tercih ediniz.

 Oluşturduğunuz UCS’leri gerekli
görüyorsanız mutlaka kaydedin.

 UCS oluşturmanın diğer seçeneklerini
de deneyiniz.

 Örneği Uygulama Faaliyeti-1 olarak
kaydediniz.

UYGULAMA FAALİYETİ
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Şekil 1.7: Bir kutunun 3B görünümü
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ÖLÇME VE DEĞERLENDİRME

A- OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Uzaydaki her bir nesneye ait noktanın bir orijine göre konumu vardır.

2) Bir düzlem XYZ gibi üç eksenden meydana gelir.

3) WCS çok sayıda tanımlanabilir.

4) UCS çok sayıda tanımlanabilir.

5) XY, XZ, YZ eksenleri ayrı ayrı düzlem oluşturabilir.

6) UCS komutu sadece yeni çalışma düzlemleri oluşturmayı sağlar.

7) UCS komutu yeni UCS oluşturur ve bunlarla ilgili düzenlemeler de yapar.

8) Daha önce çalışılmış UCS’ye dönmek için UCS komutu, ardından Previous seçimi

yapılmalıdır.

9) UCS’den WCS’ye geçmek için WCS komutu kullanılmalıdır.

10) UCS’leri döndürmek için Rotate komutu kullanılır.

Cevaplarınızı cevap anahtarı ile karşılaştırınız.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B- PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, yaptığınız 3B koordinat sistemi
uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre, evet- hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Amaç
3B koordinat sistmini tanımak, yeni
koordinat sistemi tanımlamak.

Adı soyadı

Konu 3B Koordinat sistemi. Sınıf Nu.

Değerlendirme Ölçütleri Evet Hayır

1 3 boyut kavramını öğrendiniz mi?

2 3 boyutlu uzayı öğrendiniz mi?

3 Orijin nedir, öğrendiniz mi?

4 Kaç türlü koordinat sistemi vardır öğrendiniz mi?

5 WCS koordinat sistemini öğrendiniz mi?

6 UCS koordinat sistemini öğrendiniz mi?

7 Farklı UCS’ler oluşturmayı öğrendiniz mi?

8 Oluşturulan UCS’leri kaydetmeyi öğrendiniz mi?

9 Kaydedilen UCS’leri aktif kılmayı öğrendiniz mi?

10
Çizgi, çember vb. nesneleri baz alarak UCS oluşturmayı
öğrendiniz mi?

11
UCSICON komutu ile UCS ikonu ayarlarını yapmayı
öğrendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME
Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek

eksiklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ -2

Uygun ortam sağlandığında, 3 boyutlu (3B) oluşturulmuş bir modelin görünüşlerini
elde etmeyi ve modeli gerçek zamanlı izleme yöntemlerini öğrenebileceksiniz.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlar olmalıdır:

 Bir nesnenin temel kaç görünüşü vardır, bilmelisiniz.

 Kamera ve benzeri araçlar nesneleri nasıl görüntülüyor, araştırınız.

Araştırmalarınız için, teknik resim kitapları ve internet ortamından yararlanınız.
Değişik kamera ve fotoğraf makinesi gibi araçlar hakkında bilgi edininiz. Kazanmış
olduğunuz bilgi ve deneyimleri arkadaş gurubunuz ile paylaşınız.

2.3. BOYUTLU GÖRÜŞ PENCERELERİ VE
ETKİLEŞİMLİ İZLEME

2.1. Görüş Pencereleri

3 boyutlu (3B) çizim yapıldığında tek bir görüntüleme penceresi, genellikle modeli /
tasarımı algılamakta yetersiz kalır. Plan düzlemde bakılmış bir binanın yükseklik algılaması
yapılamayacağından, farklı bir pencereden de diğer bakış yönlerine göre görüntüleme
yapılabilir. Bunun için VIEWPORTS komutu kullanılır. Kısaca VPOTRS da kullanılabilir.
Komut ve seçeneklerine üst mönü listesinden View > Named Viewports…, New
Viewports gibi seçimlerle ulaşılabilir. Aynı zamanda aşağıda Şekil 2.1’de verilen
Viewports araç çubuğunu da kullanmak mümkündür.

Komut Model ve Pafta (Layout) ortamında çalıştırılabilir. Model ortamda görünüm
pencerelerinden istenileni aktif kılmak için, ilgili görünüm penceresinin üzerinde her hangi
bir yerini tıklamak yeterlidir. Aktif olan pencere daha kalın çerçeveli olarak gösterilir. Pafta
ortamda ise kâğıt (Parer) modundan Model moduna geçmek yeterlidir. Kâğıt modundan
model moduna geçmek için görünüm penceresini çift tıklamanız gerekir. Bundan sonra diğer
görünüm pencereleri de tek tıklama ile seçilebilir.

Şekil 2.1: Viewports araç çubuğu

ÖĞRENME FAALİYETİ–2

ARAŞTIRMA

AMAÇ
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2.1.1. Viewports

Command: VIEWPORTS Enter

Komut girildiğinde aşağıda Şekil 2.2’de verilen diyalog kutusu ekrana gelir. Diyalog
kutusu iki sekmeden oluşur. Görüntüleme penceresi ayarlarını yapmak için New Viewports
sekmesi kullanılır. Bu sekmenin sol tarafındaki liste bölümünden, pencere bölümleme sayısı
ve şekli için seçim yapılır. Aşağıdaki bölümlerde de pencereler arasındaki boşluk 2D (2B)
veya 3D (3B) ve aktif pencerenin görünüş seçimi yapılır. Named Viewports sekmesindeki
bölümden verilen isim seçilerek aktif duruma getirilebilir.

Şekil 2.2:Viewports New Vieworts diyalog kutusu

2.1.1.1. New Wiewports

Vports komutu altında aynı adlı sekmede yer alır( Şekil 2.2’ye bakınız).

2.1.1.2. Named Viewports

Vports komutu altında aynı adlı sekmede yer alır (Şekil 2.3’e bakınız).
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Şekil 2.3:ViewortsNamed Viewpots diyalog kutusu

2.1.2. Named Views

Vports pencere bölümleme sistemini kontrol ederken, Named View aktif pencerenin
bakış doğrultusunu, dolayısıyla o anki görüntü pozisyonunu belirler / kaydeder / aktif
duruma getirir. Üst menü View > Named Views… ile komut satırından VIEW ya da kısaca
V ile komut çalıştırıldığında aşağıda Şekil 2.5’te verilen diyalog kutusu ekrana gelir. Komut
ve seçenekleri için aşağıda Şekil 2.4’te verilen araç çubuğunu kullanmak da mümkündür.

Şekil 2.4: View araç çubuğu

Sağ tarafta yer alan düğmelerden New tıklanarak, görüntü bir isim altında kaydedilir.
Bu şekilde isim verilen görüntüler aynı yerdeki Set Current düğmesine basılıp OK
düğmesine basıldığında ilgili görüntü aktifleştirilmiş olur.

Öğrenme Faaliyeti - 1 bölümünde oluşturulan örneğe yukarıda öğrendiğiniz
komutları uygulayınız.
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Şekil 2.5: View araç çubuğu

Yandaki üst mönü View > 3D
Views mönüsü içinde, ana
görünümleri elde edecek seçimler
vardır.

Top: Üst görünüş, Bottom: Alt
görünüş, Left : Sol yan görünüş,
Front: Ön görünüş, Back: Arka
görünüş, SW: Güneybatı, SE:
Güneydoğu, NE: Kuzeydoğu ve NW:
Kuzeybatı izometrik görünüşlerini
verir. Plan görünüm için üst görünüm
olan Top seçimi yapılmalıdır. Bu ana
görünüşlerde, fare kenetleme
doğrultusunda doğrudan boyut
girilebilir (Şekil 2.6’ya bakınız).

Şekil 2.6: 3D Views mönüsü

2.2. Etkileşimli İzleme

Bazı durumlarda modeli daha iyi algılayabilmek için, çeşitli bakış doğrultularıyla
sezgisel olarak görüntülemek gerekebilir. Bunun için gerçek zamanlı görüntüleme olanağı
veren 3DORBIT komutu kullanılır. Komut kısa olarak 3DO olarak da çalıştırılabilir. Komut
üst menüden View > 3D Orbit seçimi ile de çalıştırılabilir. Ayrıca aşağıda Şekil 2.7’de
verilen araç çubuğu da kullanılabilir.
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Şekil 2.7: 3D Orbit araç çubuğu

2.2.1. 3D Orbit İle Model İzleme

3B Modeli oluşturduktan sonra modelin 3B görüntüsünü, sanki bir kamera aracılığıyla
görüntülenmesine benzer şekilde gerçek zamanlı olarak görüntüler. Bunun için komut
çalıştırıldıktan sonra, farenin sol (seçim) tuşunu basılı tutarak, fareyi yukarı – aşağı, sağa –
sola vb. şekilde hareket ettirerek modelin istenilen bakış doğrultusunda görüntülenmesini
sağlayabilirsiniz. Ancak bu hareketin, fare imlecinin yeşil renkte Orbit çemberi içindeyken
yapılması unutulmamalıdır. Çember dışına çıkıldığında model, ekran düzlemine göre saat
yönü ya da tersine döner.

Şekil 2.8: 3D Orbit uygulaması

Kullanılan fare (Mouse) intelli olarak bilinen orta tuşlu ve tekerlekli ise tekerlek zoom
komutu için, tuş ise pan komutu için kullanılabilir. Ayrıca aşağıda Şekil 2.9’da gösterildiği
gibi fare sağ tuş mönüsünü kullanmak da mümkündür.
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Şekil 2.9:Üst mönü View’de 3D Orbit seçimi

Bu sağ tuş mönüsü ile bir çok Orbit alt seçeneklerine ulaşmak mümkün. Bu mönüden
çıkmak için mönüdeki Exit seçimini yapınız veya klavyedeki ESC tuşuna basınız.

2.2.2. 3D Orbit ile Görüntüleme

Yukarıda anlatıldığı gibi, modeli belli bakış doğrultusuna getirdikten sonra Orbit
komutundan çıkılarak o anki görüntünün sabitlenmesi sağlanır. Eğer ana görüntülerden biri
elde edilmek isteniyorsa, fare sağ tuş mönüsündeki Preset View ya da Saved View seçimleri
ile ekrana gelen aşağıda Şekil 2.10’da gösterilen listeden gerekli seçim yapılır.

Şekil 2.10: 3D orbit ile görünüş seçimleri
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2.2.3. 3D Orbit ile Kırpma Düzlemleri

3B model, bir projeyi / fikri anlatacak şekilde eksiksiz oluşturulmuş ise bilindiği üzere
bu modelden bütün görünüşlerini elde etmek mümkündür. Daha ileri gidilerek kırpma
düzlemleri, bir anlamda kesit düzlemleri tanımlanarak modelin kesitini de elde etmek
olanaklıdır. Daha önce oluşturduğumuz model içine BOX komutu ile bir katı kutu ve CONE
komu ile katı koni modeli oluşturunuz. Kutu ve koninin boyutlarını sezgisel (hayali) olarak
alınız.

Kırpma yapılacak düzlem, bakış doğrultusuna dik olduğundan öncelikle bunu
ayarlamak gerekir. Aşağıdaki Şekil 2.11’deki örnekte sağ yan görünüş seçilidir. Bu
durumda kesme düzlemi de bu bakış doğrultusuna dik, sağ yan görünüşe paralel seçilmiş
oldu.

a- Adjust Cliping Planes b- Modelin perspektif görünüşü düzlemi aktif

b- Ön kesme düzlemi pasif d- Ön kesme düzlemi aktif

Şekil 2.11: 3D Orbit ile kırpma (kesit) oluşturma
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3D ORBIT komutunu çalıştırıp fare sağ tuş mönüsünden More ardından, Adjust
Clipping Planes seçimi yapınız. Bu seçim yukarıda Şekil 2.11.a’da verilen aynı adlı
pencereyi ekrana getirecektir. Pencerenin beyaz alanı kırpma sonucunu görüntüler. Yeşil
olan kırma düzlemi arka kırpma düzlemini, siyah olan ise ön kırma düzlemini kontrol eder.
Bakış yönü yukarı doğrudur. Fare ile kesme düzlemi üzerinde gidilip fare sol tuşunu basılı
tutarak yerini yeniden belirlemek mümkündür. Kesit alma işlemi gerçek zamanlı olarak
pencerede gözlemlenebilir.

Bu kırpma düzlemleri kapatılıp / açılabilir. Bunun için için 3DORBIT aracının More
komut listesindeki Front Clipping On (ön kesme düzlemi) ve Back Clipping On (arka
kesme düzlemi) komutları kullanılır. Bunun için Adjust Clipping Planes penceresindeki
araç çubuğu da kullanılabilir.

2.2.4. 3D Orbit Sürekli Modunda (Continuous Orbit) Çalışma

Modelin devamlı olarak bir yörüngede, belirlenen hızda (bu hız modele, bilgisayarın
fiziksel donanımına ve sizin fareyi basılı tutup sürükleyip bırakma hızına göre belirlenir)
devamlı olarak hareket eder. Bu da tasarımcı için sunum kolaylığı sağlar.

Komutu çalıştırmak için, üst mönüden View > 3D Orbit seçimi yapılır ya da komut
satırından 3DO girilir. Ardından aşağıda Şekil 2.12’de verilen 3D Orbit sağ tuş mönüsünden
More > Continuous Orbit seçimi yapılır.

Şekil 2.12: 3D Orbit > More komut seçimi
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Programı çalıştırınız.

 Daha önce Öğrenme Faaliyeti - 1’de
çizmiş olduğunuz Şekil 1.7’de verilen
modeli açınız.

 Aktif (çalışmakta olduğunuz ekran)
ekranınızı VPOTRS komutu ile yatay 2 ve
düşey 2 pencere olmak üzere 4 pencereye
bölünüz.

 Pencereleri aktif yapmak için üzerini
tıklayınız.

 Ön, üst ve sağ yan görünüşü ve perspektif
görünüşü, görünüm pencerelerine
yerleştiriniz.

 Gerekirse oluşturduğunuz görümün
pencerelerini kaydedeniz.

 Kaydettiğiniz görünümleri aktif duruma
getiriniz.

 Modeliniz içine basit kutu ve koni
eklemesi yapınız.

 3D ORBIT komutu ile modelinizi çeşitli
bakış açılarında inceleyiniz.

 Modelinize kesme düzlemleri uygulayarak
kesitlerini çıkartınız.

 Komutları kullanırken veya alt
seçeneklerini seçerken komut satırı
kullanmayı tercih ediniz.

 OSNAP modlarını gerektiğinde
kullanmayı unutmayınız.

 Modeliniz içinde kullanacağınız kutu
(BOX) ve koni (CONE) katı model
komutları olup bunları üst görünüş
penceresinde sezgisel (hayali) olarak
oluşturunuz.

 Modelinizi Öğrenme Faaliyeti - 2 olarak
kaydedin.



UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

A- OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Model ortamda görünüm pencereleri oluşturulamaz.

2) Pafta ortamında görünüm pencereleri oluşturulabilir.

3) Görünüm pencerelerine sadece belli (ön, sağ yan vb.) görünüşler yerleştirilir.

4) Görünüm pencereleri kaydedilebilir – tekrar çağırılabilir.

5) Katı modellerin kesitleri çıkartılabilir.

6) 3D Orbit, VPOTRS ve VIEW komutları için araç çubukları kullanılamaz.

7) Modelimizi gerçek zamanlı olarak her açıdan sürekli görüntüleme olanağımız vardır.

8) Kesme (kırpma) düzlemleri aktif ve pasif duruma getirilemezler.

Cevaplarınızı cevap anahtarı ile karşılaştırınız

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B- PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, oluşturduğunuz modellerin
görünüşlerini elde etmeyi ve gerçek zamanlı görüntülemeyi değerlendiriniz.

Gerçekleşme düzeyine göre evet - hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Amaç
3 boyutlu modelin görünüşlerini elde etme
ve modeli gerçek zamanlı izlemek.

Adı soyadı

Konu
3B görüş pencereleri ve etkileşimli

izleme.
Sınıf No

Değerlendirme Ölçütleri Evet Hayır

1
Model veya pafta çalışma ortamını pencerelere bölmeyi
öğrendiniz mi?

2 Temel görünüşleri elde etmeyi öğrendiniz mi?

3 Pencerelere istenilen görünüşü getirmeyi öğrendini mi?

4 Pencere bölümlemeyi, isimlendirmeyi öğrendiniz mi?

5 İsim verdiğiniz encereyi aktif kılmayı öğrendiniz mi?

6
Modelinizi “3D Orbit” aracı ile gerçek zamanlı izlemeyi
öğrendiniz mi?

7
Modelinizi “3D Orbit” aracı ile kırpmayı (kesit almayı)
öğrendiniz mi?

8
Kırpma (kesme) düzlemlerinin yerini değiştirmeyi öğrendiniz
mi?

9 Kesme düzlemlerini açıp / kapatmayı öğrendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ - 3

Uygun ortam sağlandığında, 3B oluşturulmuş yüzeylerin ya da tel çerçeve şeklinde
kaplanmış modellerin boyalı / gölgeli görüntülerini elde edebileceksiniz.

Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlar olmalıdır:

 Bir model tek renkli veya tel çerçeve şeklinde nasıl algılanır?

 Boyalı gölgeli bir model nasıl algılanır, araştırınız.

 Çizgi film ve benzeri animasyonlar hangi aşamalarla, nasıl yapılıyor, araştırınız.

Araştırmalarınız için değişik bilgisayarlı çizim ve animasyon programları, internet
ortamı ve animasyon yapan kişiler yararlı olacaktır.

3. ÜÇ BOYUTLU MODEL GÖLGELENDİRME

3.1. Model Gölgelendirme

3B olarak modellenmiş yüzey modeller ya da katı modeller aslında, noktalar
(vertexler), noktaların oluşturduğu kenarlar (edge), kenarların oluşturduğu yüzeyden (face)
meydana gelir. En basit yüzey üç noktadan oluşan üç kenarlı poligondan meydana gelir.

3B nesneleri oluşturma, seçme ve düzenleme aşamasında, kullanılan görüntüleme
şekli önemlidir. Bazen modeli tel kafes Wireframe şeklinde bazen de boyalı / gölgeli
(Shade) modda görmek isteyebilirsiniz. Bunu o anki gereksinime göre kendiniz
belirleyebilirsiniz.

3.1.1 Shademode

Modeli oluşturduktan sonra algılama, düzenleme ve seçim kolaylığı bakımından çeşitli
görüntüleme tercihleri kullanılabilir. Bunun için SHADEMODE komutu kullanılır. SHA kısa
yolu da kullanabilirsiniz. Komuta üst menüden View > Shade seçimi ile de ulaşabilirsiniz.

Şekil 3.1’de verilen Shade adlı araç çubuğundan da aşağıda anlatılan boyama /
gölgeleme modlarına ulaşabilirsiniz.

Orbit komutu sağ tuş menüsünde yer alan Shading Modes komut listesinde de bu
görüntüleme modlarına yer verilmiştir (Şekil 3.2’de a ve b’ye bakınız).

ÖĞRENME FAALİYETİ–3

ARAŞTIRMA

AMAÇ
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Şekil 3.1: Shade araç çubuğu

a)

b)

Şekil 3.2: Shade- gölgeleme- boyama seçenekleri

3.1.1.1. 2D Wireframe

3B modeli tel kafes şeklinde ve nesneleri kendi renginde gösterir. Bütün noktalar ve
kenarlar görünür haldedir. UCS ikonu normal ikon şeklindedir. Daha çok nesne seçimi
yaparken tercih edilir (Şekil 3.3.a.1’e bakınız).

1) 2)
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3) 4)

Şekil 3.3.a: Gölgeleme – boyama uygulaması

3.1.1.2. 3D Wireframe

3B modeli tel kafes şeklinde ve nesneleri kendi renginde gösterir. Bütün noktalar ve
kenarlar görünür haldedir. UCS ikonu 3B ikon şeklindedir (Şekil 3.3.a.2’ye bakınız).

3.1.1.3. Hidden

3B modeli çizgi şeklinde ve kendi renginde gösterir. Sadece bakış doğrultuna göre,
önde kalan nokta ve kenarları gösterir. Bu durumda model algılaması güçlüdür. Ancak nesne
ve nokta seçimleri daha zor olabilir. UCS ikonu 3B ikon şeklindedir (Şekil 3.3.a.3’e
bakınız).

3.1.1.4. Flat Shaded

3B modeli kenar renginde boyalı / gölgeli gösterir. Sadece bakış doğrultuna göre, önde
kalan poligonları (kenarları göstermeden) ve oluşturduğu yüzleri gösterir. Bu durumda
model algılaması çok güçlüdür. Ancak nesne ve nokta seçimleri daha zor olabilir. UCS ikonu
3B ikon şeklindedir (Şekil 3.3.a4’e bakınız).

1) 2)
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3) 4)

Şekil 3.3.b: Gölgeleme – boyama uygulaması

3.1.1.5. Gouraud Shaded

3B modeli kenar renginde boyalı / gölgeli gösterir. Sadece bakış doğrultuna göre, önde
kalan poligonlar (kenarlar gösterilmeden) yüzleri gösterir. Bu durumda model algılaması çok
güçlüdür. Ancak nesne ve nokta seçimleri daha zor olabilir. UCS ikonu 3B ikon şeklindedir
(Şekil 3.3.b.1’e bakınız).

3.1.1.6. Flat Shaded,Edges On

3B modeli kenar renginde boyalı / gölgeli gösterir. Sadece bakış doğrultuna göre, önde
kalan kenarları, poligonları ve oluşturduğu yüzleri gösterir. Bu durumda model algılaması
çok güçlüdür. Ancak nesne ve nokta seçimleri daha zor olabilir. UCS ikonu 3B ikon
şeklindedir (Şekil 3.3.b.2’ye bakınız).

3.1.1.7. Gouraud Shades,Edges On

3B modeli kenar renginde boyalı / gölgeli gösterir. Sadece bakış doğrultusuna göre,
önde kalan kenarları (poligonları göstermeden) ve oluşturduğu yüzleri gösterir. Bu durumda
model algılaması çok güçlüdür. Ancak nesne ve nokta seçimleri daha zor olabilir. UCS ikonu
3B ikon şeklindedir (Şekil 3.3.b.3’e bakınız).

3B modeller sadece boyalı olarak sunulmazlar. Asıl sunum Render denilen modellere
atanan ışık, doku ve çevre elamanları sonucunda oluşan resimlerdir (Şekil 3.3.b.4’e bakınız).

3.2. Görsel Yardımcılar (VISUAL AIDS)

3.2.1. 3 Boyutlu Izgara (Grid)

3B ızgara (grid) noktalardan oluşan düzlem yerine, karelerden oluşan bir düzlemdir.
Hangi düzlemde çalışıldığını ve düzlemde oluşturulan nesnelerin konumunu daha iyi
algılamak için kullanılabilir. Normal grid açıp / kapatma işlemi buna da uygulanabilir.
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Yanda Şekil 3.4’te görüldüğü gibi
çalışılan düzlem gayet açık bir şekilde
görülmektedir. Düzlem üzerinde bir
kutu nesnesi görülmekte olup, kutu bu
düzlem üzerine oturmuştur. Bu
aşamada bütün çizimler bu düzlem
üzerinde gerçekleşir.

Şekil 3.4: 3B ızgara (Grid)

3.2.2. 3 Boyutlu UCS İkonu

3B UCS ikonu iki boyutlu olana göre, koordinat ve konum belirlemede çok etkilidir.
İkon 3B çalışmalar için bir zorunluluktur. İkon çizim programlarda neredeyse standart
özelliktedir. Yani X ekseni kırmızı, Y ekseni yeşil, Z ekseni de mavi renklidir. Bu birçok
yerde kullanılan renk (Red-Green-Blue: RGB) standardına uyar.

3.2.3. 3 Boyutlu Pusula (Compass)

3D Orbit komutu içinde yer alır. 3B modelleri gerçek zamanlı görüntülerken X, Y ve
Z eksenlerinden oluşan yörüngeyi de görüntüler. Modeli görüntülerken, uzaydaki konumunu
daha iyi sezgilenir. Aktif hale getirmek için Orbit sağ tuş mönüsünden Visual Aids >
Compass seçimi yapılmalıdır. Ayrıca bu mönüden UCS ikonunu kapatıp / açmak da
mümkündür (Şekil 3.5’e bakınız).

a) b)

Şekil 3.5: 3B Compass uygulaması
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3.2.4. Çizimi Tazeleme (Regen)

Bilgisayarda yapılan çizimde her bir nesnenin konumu, rengi, çizgi tipi vb. gibi
özellikleri bir veri tabanında tutulur. Çizimler yoğunlaştığında özellikle 3B çizimlerde nesne
seçme, zoom yapma vb. işlemleri zorlaşır. Bu durumda çizimin veri tabanının yeniden
hesaplanması gerekir. REGEN komutu bunu yapar, yani bir anlamda çizimi tazelemiş olur.

3.2.5. Model Düzenleme

Bu modülün konusu olan yüzey modellerin kendine özgü düzenleme komutları
yoktur. Ancak daha önceki modüllerde anlatılan, koordinat girişleri, PLINE, PEDIT,
STRETCH vb. komutları yeniden gözden geçirmekte yarar vardır.

3.3. Modeli Kaydetme

Oluşturduğunuz her bir modeli isim vererek sık sık kaydediniz. Gerekiyorsa daima
yedeklerini almayı ihmal etmeyiniz. Bilindiği üzere kaydetmek için SAVE komutu
kullanılmaktadır.
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler

 Programı çalıştırınız.

 Şekil 3.3.a ve Şekil 3.3.b’de görülen 3B

modele benzer, kendiniz bir model

oluşturunuz.

 Shademode komutu seçeneklerini

modelinize tek tek uygulayınız.

 Modelinizdeki görünüm ayrıntılarını

gözlemleyiniz.

 Modeldeki (masa, ayakları vb.) kutuları

ai_box, kubbeyi ai_dome, küreyi

ai_sphere komutları ile oluşturabilirsiniz.

Komutlarla ilgili geniş bilgi Öğrenme

faaliyeti - 5 te verilmiştir.

 Komut uygulamalarında komut satırını

veya shade araç çubuğunu kullanınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

A- OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Shademode komutu ile model sadece boyalı görüntülenir.

2) 3D Orbit komutu içinde gölgeli / boyalı görüntüleme yapılabilir.

3) Modeli çizgi (tel kafes) şeklinde görüntülemek için, FlatShaded seçimi yapılmalıdır.

4) Gölgeli / boyalı görünüm için üst menü, komut satırı, araç çubuğu, 3D orbit aracı

kullanılabilir.

5) UCS ikonu 3B çizimlerde mutlaka açık olmalıdır.

Cevaplarınızı cevap anahtarı ile karşılaştırınız

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B- PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, modellere uyguladığınız boyama /
gölgeleme işlemlerini değerlendiriniz.

Gerçekleşme düzeyine göre, evet- hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Amaç
3B Modelleri boyalı / gölgeli olarak görsel
hale getirme.

Adı soyadı

Konu 3 Boyutlu model gölgelendirme. Sınıf Nu

Değerlendirme Ölçütleri Evet Hayır

1
3B modeli boyalı / gölgeli göstermenin modeli algılamadaki
önemini kavradınız mı?

2 3B modeli boyalı göstermeyi öğrendiniz mi?

3 3B modeli tel kafes şeklinde göstermeyi öğrendiniz mi?

4
3B modelin boyalı / tel çerçeve görünümü arasındaki farkı
öğrendiniz mi?

5
3B modelin bakış yönüne göre, arkada kalan çizgilerini
gizlemeyi öğrendiniz mi?

6 3B ızgara (grid) oluşturmayı öğrendiniz mi?

7
3 Boyutlu modeli, 3D Orbit aracındaki Pusula (Compass) ile
görüntülemeyi öğendiniz mi?

8
3B çizimlerde gerektiğinde REGEN ile çizimi tazelemeyi
öğendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksikliklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ - 4

Uygun ortam sağlandığında basit tel kafes şeklinde kutu modeli oluşturacaksınız. Bir
kırma çatın tel kafes modelini yapacaksınız.

 Çatılarla ilgili ön bilgiler edininiz. Çatı mahyaları ve eğimleri hakkında araştırma
yapınız. Bilgisayar ortamında çizim yaparken eğik bir doğru parçası nasıl çizilir
araştırınız.

 Araştırmalarınızda çatı ile ilgili meslek kitapları size yararlı olacaktır. Bilgisayarlı
çizim programlarında, koordinat girişleri hakkında bilgi veren kitaplardan
yararlanabilirsiniz. Araştırmalarınız sonucunda elde ettiğiniz bilgileri
arkadaşlarınızla karşılaştırınız.

4. ÇİZGİLER VE FİLTRELER

4.1. Tel Kafes Kutu Çizim

Tel kafes, bir yüzeyi oluşturan kenarların tel şeklinde görüntülenmesi demektir. Bunu
çocukluğumuzda telden yaptığımız arabalara benzetebiliriz. Eğer bu telden arabamızın,
telden oluşan kenarlarını kaplarsak araba, yüzeyleri olan modele dönüşmüş olur. Tel kafes;
Line, Pline ve 3dpoly gibi komutlarla elde edilebilir. Bundan başka yüzey modelleri ve katı
modelleri de tel kafes şeklinde görüntülemek mümkündür.

Tel kafes görünümü, 3B nesneleri seçme ve düzenleme aşamasında bazen zorunlu hale
gelir. Ayrıca bilgisayarın hafıza ve işlemci gibi fiziki kaynaklarını daha az kullanır. İngilizce
tel kafes görünüme Wireframe adı verilmektedir.

Tel kafes görünüm seçmek için, gölgeleme / boyama modu olan Shade komutu ile
kontrol edilebilir. Komut ile ekrana gelen seçeneklerden Wireframe seçimi yapılır.

4.1.1. Line

Line komutu bilindiği üzere çizgi oluşturmakta kullanılır. Daha önceki öğrenme
faaliyetlerinde de bahsedildiği gibi, Line nesnelerinin nokta koordinatlarını girerken, X ve Y
koordinatlarına göre çizdik. Z ile gösterilen koordinatı biz vermedik, dolayısıyla bilgisayar
bunu sıfır (0) olarak aldı. Tel kafes vb. çizimlerde, nesneyi XY düzleminden daha aşağı veya
yukarı taşıma / kopyalama vb. eylemlerde de Z eksenini düşünmemiz gerekir. Bu ister
WCS’ye ait XY düzlemi olsun, ister UCS’ye ait XY düzlemi olsun fark etmez.

ÖĞRENME FAALİYETİ–4

ARAŞTIRMA

AMAÇ
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DOĞRUNUN XY DÜZLEMİ İLE
YAPTIĞI AÇI

DOĞRUNUN X EKSENİYLE
YAPTIĞI AÇI

DOĞRUNUN XY DÜZLEMİNE OLAN İZDÜŞÜMÜ

DOĞRUNUN GERÇEK BOYU

Bir tel kafes model oluşturmak için aşağıdaki işlemler yapılabilir:

 Line (çizgi) veya Rectangle (dörtgen) komutu ile taban oluşturulur.

 Oluşturulan dörtgen Z ekseni doğrultusunda kopyalanır.

 Line komutu ile düşey çizgiler çizilir.

Uzayda bir 3B doğru parçasını incelediğimizde şunları görürüz:

 Bir doğru parçası A ve B noktalarının oluşturulduğu iki noktadan meydana

gelir.

 Bu noktaların oluşturduğu doğru parçası uzay boşluğunda tanımlanan

düzlemlere göre (XY düzlemi gibi) konumlandırılır.

 Bu konuma göre;

 A ve B noktalarının X,Y ve Z koordinatları vardır.
 AB doğru parçasının gerçek boyu vardır.
 AB doğru parçasının düzlemlerde iz düşüm boyu vardır.
 X, Y ve Z eksenlerine olan iz düşüm boyları olan Delta X, Delta Y ve Delta

Z vardır.
 Doğru parçasının X ekseni ile yaptığı açı değeri vardır.
 Doğru parçasının XY düzlemine (ve diğer düzlemlere) olan açı değeri

vardır.
 Çizginin bulunduğu düzlemden olan yükseklik değeri olan Thickness değeri

vardır.
NOT: Thickness komutu ile istenilirse çizgiye yükseklik değeri
kazandırılarak 3B nesne elde edilebilir. Ancak bu çok basit modeller için
tercih edilir. Çünkü düzenlenme esnekliği yetersizdir. Bu tür modellerin
üst boşlukları yüzey kaplanmalıdır. Aşağıdaki şekilde sağ tarafta basit
bir kutu çizimi verilmiştir. Üstteki kutunun üst tarafı 3dface ile
kaplanmıştır (Şekil 4.1.b).

Aşağıda Şekil 4.1.a’da bir çatı eğik mahyasının 3B incelemesine yer verilmiştir.

a) Çatı eğik mahyasında bir doğru parçası. b) Thickness değeri olan bir uygulama...
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Şekil 4.1: Uzayda doğru parçasının incelenmesi

4.1.2. Koordinat Girişleri Aşağıdaki Yöntemlerden Biri Seçilerek Girilebilir

3B koordinat girişinde aşağıdaki yöntemlerden biri, daha doğrusu eldeki verilerden
hangisi var ise, en kolay ve kısa olanı tercih edilebilir. Bir koordinat sistemiyle başlayıp aynı
sistemle devam şartı yoktur.

4.1.2.1. x,y,z Şeklinde Kartezyen / Mutlak Koordinat Girişi

Bu şekilde noktanın yeri üç eksene göre belirlenir. Noktanın konumu 0,0,0 noktası
esas alınarak belirlenir.

Bunlar sırasıyla;

x= Noktanın orijine göre, X ekseni yönündeki uzaklığı.

y= Noktanın orijine göre, Y ekseni yönündeki uzaklığı.

z= Noktanın orijine göre, Z ekseni yönündeki uzaklığı şeklindedir.

A ve B noktalarının koordinatları aşağıdaki gibi x,y,z olarak girilir.

Command: Line  (Enter)

Specify first point or [Undo]: x,y,z Enter

Specify next point or [Undo]:x,y,z Enter

Noktaların girişi bu şekilde devam eder.

4.1.2.2. @ x,y,z Şeklinde Relativ Koordinat Girişi

Bu koordinat girişi kartezyen koordinat girişine benzer. Ancak bilindiği gibi, @ işareti
ile bulunulan yer; 0,0,0 noktası olarak kabul edilmektedir.

Command: Line  (Enter)

Specify first point or [Undo]: x,y,z Enter

Specify next point or [Undo]:@ x,y,z Enter

Noktaların girişi bu şekilde devam eder.

4.1.2.3. Spherical - Kutupsal Koordinat Girişi

Koordinat girişi L < < şeklindedir. Burada da @ işareti kullanılarak, bulunulan
yerin; 0,0,0 noktası olarak kabul edilmesi sağlanır.

Sırasıyla buradaki değerler;
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L= XYZ uzayında doğru parçasının gerçek -tam- boyu (bu durumda XY düzleminde
doğrunun iz düşümü çizilmiş olur).

= XY düzleminde, doğru parçasının iz düşümünün X ekseni ile yaptığı açı.

= Doğru parçasının XY düzlemiyle yaptığı açı şeklindedir.

Command: Line  (Enter)

Specify first point or [Undo]: x,y,z Enter

Specify next point or [Undo]:@ L < < Enter

Noktaların girişi bu şekilde devam eder.

4.1.2.4. Cylindrical - Silindirik Koordinat Girişi

Koordinat girişi L<,z şeklindedir. Yine burada da @ işareti kullanılarak bulunulan
yerin 0,0,0 noktası olarak kabul edilmesi sağlanır.

Sırasıyla buradaki değerler,

L= XY düzleminde doğru parçasının iz düşüm boyu. Gerçek boy XYZ düzlemlerine
göre çizilmiştir.

= Doğru parçasının XY düzlemi ile yaptığı açı.

z = XZ düzleminde doğru parçasının Z ekseni doğrultusundaki iz düşüm boyu ( z).

Command: Line  (Enter)

Specify first point or [Undo]: x,y,z Enter

Specify next point or [Undo]:@ L<,z Enter

Noktaların girişi bu şekilde devam eder.

4.1.3. Koordinat Girişinin Çatı Eğik Mahyasına Uygulanması

Aşağıda Şekil 4.2’de bir çatı eğik mahyasının ölçüleri ve line komutu ile 3B çizgi
nasıl çizilir, buna ait incelemeye yer verilmiştir.

Verilenler: Doğru parçasının gerçek boyu 200 cm, iz düşüm boyu 178.2 cm,
x=y=126 cm,  z 90.79 cm (kırılma noktasındaki dikme boyu),  45 derece,  27 derece
olan çatı eğik mahyanın ilk uç noktasının koordinatı A(50,50,0)’dır.

Aşağıda söz konusu çizginin sorgulaması görülmektedir.
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NOT: Burada çizginin bulunduğu düzlemden olan yükseklik değeri olan Thickness
görülmez. Varsayılan olarak bu değer sıfır (0) kabul edilir.

Şekil 4.2: Çatı eğik mahyasının incelenmesi

Bir çatı eğik mahyasının çizimi aşağıda değişik yöntemlerle örneklenmiştir.

Kartezyen koordinat sistemine göre;

Command: Line  (Enter)

Specify first point or [Undo]: 50,50,0 Enter

Specify next point or [Undo]: 176,176.90.8 Enter

Relativ koordinat girişine göre,

Command: Line  (Enter)

Specify first point or [Undo]: 50,50,0 Enter

Specify next point or [Undo]:@126,126,90.79 Enter

Kutupsal koordinat girişine göre,

Command: Line  (Enter)

Specify first point or [Undo]: 50,50,0 Enter
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Specify next point or [Undo]:@200<45<27 Enter

Silindirik koordinat girişine göre,

Command: Line  (Enter)

Specify first point or [Undo]: 50,50,0 Enter

Specify next point or [Undo]: @178,2<45,90.8 Enter

4.1.4. Polyline

Polyline (çoklu birleşik çizgi) Pline veya kısaca PL kısa komutu ile çalıştırılır. PL
nesneler 3B özellikli olarak çizilemezler. Yani Z koordinat değeri verilemez. Girilmeye
kalkışıldığında aşağıdaki uyarı satırı görüntülenir.

“2D point or option keyword required.”

PL nesnelerde 3B koordinat girişi olmamasına rağmen, yüzey model ve katı model
oluşturmada önemli bir yere sahiptir. PL nesneleri PEDIT komutu ile tekrardan düzenlemek
olanaklıdır. Daha önceki eğitim modüllerinden ilgili komutları tekrarlamanızda yarar vardır.

4.1.5. 3D Polyline

PL komutu ile 3B koordinat girişi oluşturmak, dolayısıyla 3B PL nesne elde etmek
olanaksızdır. Ancak 3DPOLY komutu ile bunu yapmak mümkündür. Bu komutla merdiven
korkulukları vb. şekilli modelleri oluşturmak mümkündür.

4.2. 2B Düzlemde 3 Boyutlu Kutu Çizimi

3B Modeller oluşturulurken “ancak şu şekilde modellenebilir”, veya “şu modelin şu
komutu vardır” düşüncesi modelleme yaparken esnek düşünmeyi engeller. En iyi metot “en
kısa sürede, en iyi modeli üretmektir”.

4.2.1. Osnap Modları İle

Osnap Modları kullanılarak 3B çizimde tel çerçeve nesneler, yüzey modeller ve katı
modeller rahatlıkla oluşturulabilir.

4.2.1.1. İzometrik Çizim

İki boyutlu çizimlerde Grid / Snap modları Isometric Snap moduna getirilerek 2B
düzlemde 3B çizim yapılabilir. Ancak bu 3B model oluşturmaz. Tıpkı kâğıt üzerine çizilen
3B çizimlere benzer (Şekil 4.3’e bakınız).

4.2.1.2. İzometrik Çember

2B olarak çizilen 3B modellerde izometrik çember ancak elips (Elipse) olarak
çizilebilir. 3B modellerde zaten çember görünüme göre izometrik vb. görüntülenecektir
(Şekil 4.3’e bakınız).
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4.2.1.3. İzometrik Kesit

2B olarak çizilen 3B nesneler diğer izometrik çizim yöntemleriyle çizilir. 3B olarak
oluşturulmuş nesnelerin zaten kesitleri Orbit aracı üzerinden yapılmaktadır.

4.2.1.4. İzometrik Ölçülendirme

2B olarak çizilen 3B nesneleri ölçülendirme için, Aligned yöntemini kullanınız. Daha
sonra Dimedit komutunu çalıştırınız. Buradan da Obluque ile ölçülendirme sınır çizgilerinin
ölçü çizgisi ile olan açısını yeniden düzenleyiniz (Şekil 4.3’e bakınız).

Şekil 4.3: Bir kutunun izometrik olarak çizilmesi

4.3. Nokta Filtreleri

X,Y,Z koordinatları veya XY, XZ, YZ düzlemleri kullanılarak 2B ve 3B çizimler daha
rahat yapılabilir. Örneğin aşağıda Şekil 4.4’te verilen bir P noktasını çizmek için filtre
kullanılmıştır.

Şekil 4.4: Nokta girişlerinde filtre kullanımı

Command: POINT  (Enter)

Current point modes: PDMODE=35 PDSIZE=0.0000

Specify a point: .x (nokta X)

of (burada X ekseni doğrultusunda X işaretli yer seçilir.)

need YZ : Kutu üzerinde sol üst taraftaki Z işaretli yer seçilir.
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X,Y,Z koordinatlarından her biri tek tek seçilebilir. Örneğin X,Y girildiğinde Z değeri
doğrudan sayısal olarak ya da plan üzerinde XY düzlemi belirlendiğinde Z değeri yine
doğrudan girilebilir.

Bu filtrelere OSNAP modlarının bulunduğu listeden ulaşılabilir. Bu liste Shift tuşu +
fare sağ tuş kombinasyonu ile çıkartılabilir.

4.3.1. Bir XY Filtresi ile Bir Kutu Dikey Çizgisi Oluşturma

 Line (çizgi) veya Rectangle (dörtgen) komutu ile taban oluşturunuz.

 Osnap / Endpoint aktif hale getiriniz.

 Line komu ile dörtgenin sol alt köşesine, çizginin 1.noktasını girin.

 2. nokta için, .xy filtresini girin.

 Size XY düzlemi için yer belirtmeniz istenecek. Yine aynı yeri tıklayın.

 of (need Z): Buraya kutunun yüksekliğinin sayısal değerini giriniz.

 Çoklu kopyalama ile diğer köşelere bu çizgileri kopyalayınız.

 Line komutu ile çizgilerin üst noktalarından yararlanarak tel kafes şeklindeki

kutu tamamlanır (Şekil 4.5’e bakınız).

Şekil 4.5: Nokta girişinde filtre uygulaması
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UYGULAMA FAALİYETİ

İşlem Basamakları Öneriler
 Basit bir dikdörtgen bina çatı saçağı

çiziniz.

 Yukarıda öğrendiğiniz Line ile 3B çizim
yöntemlerini kullanarak eğik mahyadan
birini, çatı köşelerinden birini çiziniz (eğik
mahyanın boyutu önemli değil).

 Bütün köşelere eğime uygun mahyaları
çoğaltınız.

 Fillet Radius=0 ayarlayarak eğik
mahyalara fillet uygulayınız.

 Mahyaların birleştiği noktaları Line ile
birleştiriniz.

 Çizimi Tel Kafes 3B Çatı olarak
kaydediniz.

 Uygulama için Şekil 4.6’ya bakınız.

 Bundan önceki modüllerde anlatılan
Pline, Pedit ve Dim (ölçülendirme)
komutlarını tekrar gözden geçiriniz.

 Uygulamaları yaparken daha çok klavye
kısa yollarını kullanmayı tercih ediniz.

 Çeşitli kutu ve çatı vb. örnekleri
çözmeye çalışınız.

Şekil 4.6: Bir kırma çatının tel kafes modeli

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME

A- OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Tel kafes şeklinde model, kolay seçim yapabilmek için kullanılır.
2) Line komutu ile 3B koordinat girişi yapılarak tel kafes görünümlü modeller

oluşturulabilir.
3) 3DPOLY komutu ile 3B koordinat girişi yapılarak tel kafes görünümlü modeller

oluşturulabilir.
4) PLINE komutu ile 3B koordinat girişi yapılarak tel kafes görünümlü modeller

oluşturulabilir.
5) İzometrik olarak 2B olarak çizilmiş, 3B görünümlü çizimler de 3B model olarak işlem

görür.
6) 3B uzayda doğrultuları kesişen nesnelere TRIM ve FILLET komutları uygulanabilir.
7) 3B çizim yapabilmek için daima koordinat filtreleri (.X, .XY gibi) kullanmak gerekir.

Cevaplarınızı cevap anahtarı ile karşılaştırınız

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B- PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, yaptığınız tel kafes model
uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre evet- hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Amaç
Tel kafes şeklinde 3B modeller
oluşturmak.

Adı soyadı

Konu 3B Çizgiler ve filtreler. Sınıf Nu.

Değerlendirme Ölçütleri Evet Hayır

1
Basit tel kafes şeklinde bir kutu modeli yapmayı öğrendiniz

mi?

2 Bir eğik doğru parçasının özelliklerini öğrendiniz mi?

3
Değişik koordinat giriş sistemlerine göre eğik doğru parçası

oluşturmayı öğrendiniz mi?

4
Basit bir kıma çatının tel kafes şeklindeki modelini yapmayı

öğrendiniz mi?

5 2B düzlemde 3B görünümlü kutu çizmeyi öğrendiniz mi?

6 2B düzlemde izometik çember çizmeyi öğrendiniz mi?

7 2B düzlemde izometrik ölçülendirme yapmayı öğrendiniz mi?

8 Koordinat girişlerinde filtre kullanmayı öğrendiniz mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.
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ÖĞRENME FAALİYETİ - 5

Uygun ortam sağlandığında 3 boyutlu yüzey modeller oluşturma alışkanlığı
kazanabileceksiniz. Hazır yüzey modeller oluşturup başka modellere dönüştürebileceksiniz.

 3 boyutlu yüzey modelleri tanımak ve ön bilgi sahibi olmak için yapmanız gereken
araştırmalar şunlar olmalıdır.

 Bir masanın üst tablası, ayakları hangi geometrik şekle benziyor? Simit hangi
geometrik şekle benziyor? Bu ve benzeri nesneleri araştınız. Vazo, bardak vb.
nesnelerin diğer geometrik nesnelerden farkı nedir araştırınız. Modeller deforme
edilerek başka formlara dönüştürülebilir mi? Araştırmalarınız için etrafınızı
gözlemleyiniz. Arkadaşlarınızla bilgi alışverişinde bulununuz.

5. 3 BOYUTLU YÜZEYLER

5.1. Bir Kutuya Yüzey Kaplama

Daha önceki öğrenme faaliyetlerinde öğrendiğimiz tel kafes modeller (tel kafes olarak
görüntülenen yüzey modeller ve katı modeller hariç) içleri boş olduğundan, bu modellerden
resim elde etmek (Render işlemi uygulamak) mümkün değildir. Çünkü modellere atanan
doku ve ışık bilgileri yüzeyler üzerinde gerçekleşir. Aşağıda tel kafes modellere uygulanan
yüzey kaplama yöntemleri anlatılacaktır. Bu bölümde anlatılan komutların çoğuna Şekil
5.1’de verilen araç çubuğundan ulaşılabilir.

Yüzey modellerin nokta konumları değiştirilerek değişik modeller elde etmek
mümkündür. Bunun için model vertex’lerinin konumunu değiştirmek yeterlidir. Bunun için
STRETCH komutu kullanılabilir.

Şekil 5.1: Surfaces araç çubuğu

ÖĞRENME FAALİYETİ–5

ARAŞTIRMA

AMAÇ
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5.1.1. 3Dface

En az tel kafesin 3 noktası girilerek yüzey oluşturur. Komut kısaca 3F olarak da
girilebilir. Yüzey oluşturulurken noktaların girilme sırası önemlidir. Aşağıda daha önce
oluşturduğumuz tel kafes modele yüzey kaplama uygulaması görülmektedir.

Uygulama şu işlem sırasına göre yapılabilir:

(Osnap / Endpoint modunun aktif olması daha hızlı işlem yapmanızı sağlayacaktır.)

Command: 3DFACE  (Enter)

3DFACE Specify first point or [Invisible]: A noktasını giriniz.

Specify second point or [Invisible]: B noktasını giriniz.

Specify third point or [Invisible] <exit>: C noktasını giriniz.

Specify fourth point or [Invisible] <create three-sided face>: D noktasını giriniz.

Specify third point or [Invisible] <exit>: Enter

Şekil 5.2: 3DFace uygulaması

Eğer komut ile yapılan işlem tamamlandıktan sonra yukarıda Şekil 5.2’de görülen (sağ
yana dikkat edin) kaplama oluşmadı ise Shade komutunu, arkasından Hide seçimini yapınız.

5.1.2. Splframe

Eğrisel nesneleri (SPLINE komutu veya PL nesnenin PEDIT ile edilmiş eğrileri)
oluşturan kırık çizgilerin görünür olup olmamasını kontrol eden sistem değişkeni. Eğrinin
hassasiyetini ayarlamak için kullanılabilir. Varsayılan değer sıfır (0) olup görünür değildir.
Şekil 5.3.a’da kırık çizgiler görüntülenmektedir.

Komut bitirildikten sonra REGEN komutunu çalıştırmayı unutmayınız.
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a) b)

Şekil 5.3: Splframe uygulaması

5.1.3. Edge

3DFACE komutu ile oluşturulmuş yüzeylerin çizgilerinin görünür olup / olmamasını
kontrol eder. Şekil 5.4, a’da yüzey oluşturulmuş ve yüzeyleri oluşturan kenarlar görünür
haldedir. Şekil 5.4, b’de aynı yüzey yine var, ancak kenarları görünür değildir.

Komut üst menüden Draw > Surfaces> Edge ile komut satırından EDGE ile
çalıştırılabilir. Ayrıca Surfaces adlı araç çubuğunda da komuta yer verilmiştir.

Command: EDGE  (Enter)

Specify edge of 3dface to toggle visibility or [Display]: Görünmeyecek kenarın,
(şekilde görünen köşegen gibi) seçimi yapılarak görünmemesi sağlanır. Eğer görünmeyen
kenarın görünmesi isteniyorsa bu kez D ile Display seçimi yapılarak aşağıdaki komut
satırına ulaşılır.

Enter selection method for display of hidden edges [Select/All] <All>: Yüzeyi
oluşturan kenar gösterilerek (görünmeyenler dahil) seçili kenarın gösterilmesini sağlar.

Komut uygulandıktan sonra REGEN ve HIDE komutlarını uygulamayı unutmayınız.

a) b)

Şekil 5.4: Edge uygulaması

5.2. İleri Düzey Yüzey Kaplama

Aşağıda daha değişik yüzey model oluşturma teknikleri anlatılacaktır. Bu modeller
oluşturulurken daha önceki modüllerde öğrenmiş olduğunuz Pline ve Pedit komutlarını da
kullanacağınızdan, bu komutları tekrarlamanız yararınıza olacaktır.
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Yüzey modeller düzenleme bakımından bazı avantajlara ve dezavantajlara sahiptir.
Modelin belli bölümlerine uygulanabilen STRETCH komutu ve tutamakların (grips’lerin)
konumlarının değişebilmesi avantaj; boşluk açma, dilimleme, birleştirme gibi özelliklerinin
olmaması ise bu modeller için dezavantaj olarak gösterilebilir.

Yüzey modellerin hassasiyeti yüzeyi oluşturan poligon (üçgen ya da dörtgen şeklinde
kapalı alanlar) SURFTAB1 ve SURFTAB2 sistem değişkenleri kullanılır. Her ikisi için de
bu değer 6’dır. Bu şu demektir: Seçilen kenarlar 6*6=36 adet poligondan oluşacaktır. Bu
değer artırıldıkça modelinizin daha gerçekçi olacak, ancak bilgisayarınızın fiziksel
kaynakları çok kullanılacaktır.

5.2.1. Edgesurf

Birbirine dokunmuş olması koşulu ile dört nesnenin (nesneler çizgi ve yay olabilir)
birlikte oluşturduğu kapalı alan yüzeyi oluşturur. Nesnelerin aynı düzlemde olması
gerekmez. Aşağıdaki Şekil 5.5’teki kutu örneğinde ortak bir düzlem olmasına rağmen, Şekil
5.6’da ki iki örnekte de düzlemler farklıdır.

Komuta üst menüden Draw > Surfaces > Edgesurf ile komut satırından EDGESURF
ile ulaşılabilir. Ayrıca Surfaces araç çubuğunda da komuta yer verilmiştir.

Command: EDGESURF  (Enter)

Current wire frame density: SURFTAB1=6 SURFTAB2=6 (Suftab bilgileri, burası
sadece bilgi için verilir.)

Select object 1 for surface edge: 1. kenarın seçimi yapılır.

Select object 2 for surface edge: 2. kenarın seçimi yapılır.

Select object 3 for surface edge: 3. kenarın seçimi yapılır.

Select object 4 for surface edge: 4. kenarın seçimi yapılır.

Şekil 5.5: Edgesurf uygulaması
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Şekil 5.6: Edgesurf ile modellenmiş örnekler

5.2.2. Rulesurf

Karşılıklı iki nesnenin, şekillerine bağlı olarak yüzey oluşturma komutudur. Aşağıda
karşılıklı kenarlar p1 ve p2 noktaları şeklinde işaretlenmiştir. Kenarların yanlış işaretlenmesi
halinde yüzeyler bozuk oluşur. Şekil 5.7’de doğru seçim, Şekil 5.8’de yanlış seçim
yapılmıştır.

Komuta üst menüden Draw > Surfaces > Rulesurf, komut satırından RULESURF ile
ulaşılabilir. Ayrıca Surfaces araç çubuğunda da komuta yer verilmiştir.

Command: RULESURF  (Enter)

Current wire frame density: SURFTAB1=6 (Surftab bilgisi)

Select first defining curve: Birinci kenarın seçimi (P1 noktasından)

Select second defining curve: İkinci kenarın seçimi (P2 noktasından)
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Şekil 5.7: Rulesurf için doğru seçim noktaları

Şekil 5.8: Rulesurf için yanlış seçim noktaları

5.2.3. Tabsurf

Bir nesne üzerinde ikinci bir nesne hareket ettirilerek (kaydırılarak) yüzey elde edilir.
Burada yol durumunda olan nesne mutlaka PLine, Spline vb. gibi birleşik nesne olmalıdır.
İki nesnenin birbirine dokunma zorunluluğu yoktur.

Komuta üst menüden Draw > Surfaces > Tabsurf, komut satırından TABSURF ile
ulaşılabilir. Diğerlerinde olduğu gibi bu komuta da Surfaces araç çubuğunda yer verilmiştir.

Command: TABSURF  (Enter)
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Select object for path curve: Seçilecek nesneye yol oluşturacak pline nesnenin
seçilmesi (A Nesneleri).

Select object for direction vector: Yol durumunda olan nesne üzerinde hareket
edecek nesnenin seçimi (B Nesnesi).

B nesnesi seçilirken, seçim nesnenin altında ise yüzeyler şekildeki gibi, üstten seçim
yapılırsa yüzeyler A nesnelerinin alt taraflarında oluşur (Şekil 5.9’a bakınız).

Şekil 5.9: Tabsurf uygulaması

5.2.4. Revsurf

Kesiti simetrik olan, dönel bir eksene sahip olan yüzey modelleri oluşturmak için
kullanılabilir. Bu modellere şişe, çaydanlık, bardak, çeşitli makine parçaları vb. nesneler
örnek oluşturur (Şekil 5.10’da bardak resmine bakınız).

Komuta üst menüden Draw > Surfaces > Revsurf, komut satırından REVSURF ile
ulaşılabilir. Ayrıca Surfaces araç çubuğunda da komuta yer verilmiştir.

Command: REVSURF  (Enter)

Current wire frame density: SURFTAB1=30 SURFTAB2=6 (surftab bilgileri)
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Select object to revolve: Döndürülerek yüzey elde edilecek nesnenin / kenarın seçimi.

Select object that defines the axis of revolution: Dönme ekseni olacak nesnenin
seçimi.

Specify start angle <0>: Başlangıç açısı. Nesnenin o anki konumu başlangıç açısını
oluşturur.

Specify included angle (+=ccw, -=cw) <360>: Döndürülecek nesnenin, eksen
etrafında kaç derece döndürüleceği belirlenir. Burada eksenin işaretlenme noktası dikkate
alınmalıdır. Şekil 5.10’da görüldüğü gibi, seçimin durumuna göre, yüzey oluşturma eksenin
saat yönünde veya tersi olmaktadır.

Şekil 5.10: Revsurf uygulaması

5.2.5. 3DMesh

Üç boyutlu olarak birleşik yüzey oluşturmakta kullanılan komuttur. Komutla aşağıdaki
şekillerde görüldüğü gibi birleşik eğrisel yüzeyler de elde edilebilir. Düzenleme komutları
uygulanarak çok değişik şekiller elde etmek mümkündür. Örnek olarak dağ görünümünde üç
boyutlu eğriler, yaprak şeklinde eğrisel yüzeyler ve bunlara benzer nesneler oluşturulabilir.

Command: 3DMESH (Enter)

Mesh M Size: Düşey kenar (sütun) sayısı (5)

Mesh N Size: Yatay kenar (satır) sayısı (4)

Yukarıdaki M ve N değerleri 2~256 arasında bir sayı olmalıdır.
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Bu değerler girildikten sonra, dörtgenleri (yamuk veya trapezleri) oluşturan her bir
köşenin (vertex) noktaları girilir. Buradaki nokta sayısı M*N kadardır. (5*4=20 nokta /
vertex)

Vertex(0,0):p1 Vertex(1,2):p8 Vertex(2,4):p15 Vertex(0,1):p2
Vertex(1,3):p9 Vertex(3,0):p16 Vertex(0,2):p3
Vertex(1,4):p10 Vertex(3,1):p17 Vertex(0,3):p4
Vertex(2,0):p11 Vertex(3,2):p18 Vertex(0,4):p5
Vertex(2,1):p12 Vertex(3,3):p19 Vertex(1,0):p6
Vertex(2,2):p13 Vertex(3,4):p20 Vertex(1,1):p7
Vertex(2,3):p14

Son vertex'e kadar noktalar girilir. Sonuçta yüzeyin çizimi tamamlanır. Yukarıdaki
vertexlere sırasıyla ve doğru olarak noktalar girilmek şartıyla poligonlar tamamlanıp yüzey
oluşur. Sırası bozulduğunda istenilen yüzey şekli elde edilmeyecektir (Şekil 5.11.a,b,c’ye
bakınız).

a) 3Dmesh uygulaması b) Pedit uygulanmış c) Farklı bir görünüş

Şekil 5.11: Mesh uygulaması

5.3. Hazır Yüzey Modeller

Yukarıda anlatılan yüzey oluşturma komutları yanında, hazır geometrik yüzey
modeller oluşturmaya yarayan komutlarda vardır. Komutlara değişik yöntemlerle ulaşmak
mümkün. Komut satırından “ai_” ön eki ile komut girişi yapılır. Örneğin kutu yüzey modeli
için ai_BOX komutunu girmek gerekir. Ayrıca aşağıda Şekil 5.12’de verilen diyalog kutusu
kullanılabilir. Bunun için üst mönü > Draw > Surfaces > 3D Surfaces… seçimi
yapılmalıdır. Buradan, ilgili modelin üzerine tıklanıp OK düğmesine basılarak komut
çalıştırılmış olur.
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Şekil 5.12: 3D Objects diyalog kutusu

5.3.1. Kutu (box)

Kutu, basit dörtgen prizmaya benzer masa tablası, masa ayağı, bilgisayar kasası gibi
nesneler oluşturmada kullanılabilir (Bilgi için Şekil 5.13’e bakınız).

Kutu çizimi için Ai_box komutu kullanılır.

Komut girildiğinde aşağıdaki iletiler ekrana gelir.

Command: ai_box  (Enter)

Specify corner point of box: Kutunun sol alt köşe koordinatı (p1).

Specify length of box: X yönündeki mesafe. Sayısal ya da koordinat olarak girilebilir
(200).

Specify width of box or [Cube]: Y yönündeki mesafe. Sayısal ya da koordinat olarak
girilebilir (200).

Specify height of box: Yükseklik, yani Z yönündeki mesafe. Koordinat ya da mesafe
olarak girilebilir (300).

Specify rotation angle of box about the Z axis or [Reference]: Sol alt köşe
noktasında, Z ekseni doğrultusunda X eksenine göre dönme açısı (0 derece).
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Şekil 5.13: Kutu modeli

5.3.2. Piramit Çizimi (Pyramid)

Pramit benzeri nesneler modellemek için kullanılır. Buna örnek olarak kırma çatı şekli
gösterilebilir (Bilgi için aşağıda verilen Şekil 5.14’e bakınız).

Command: ai_pyramid  (Enter)

Specify first corner point for base of pyramid: Piramidi oluşturacak dörtgenin 1.
noktası (p1).

Specify second corner point for base of pyramid: Piramidi oluşturacak dörtgenin 2.
noktası.

Specify third corner point for base of pyramid: Piramidi oluşturacak dörtgenin 3.
noktası (p3).

Specify fourth corner point for base of pyramid or [Tetrahedron]: Piramidi
oluşturacak dörtgenin 4. noktası. (p4) Burada istenirse, 4. nokta girilmeyip, Tetrahedron
seçeneği ile üçgen piramit de çizilebilir.

Specify apex point of pyramid or [Ridge/Top]: Piramit tepe noktası girilir ya da
Pramit tepe noktasının ne şekilde oluşturulacağı seçimi yapılır. Apex Point Normal bir tek
tepe noktası olan piramit çizmek için kullanılan seçenektir (p5).

* Ridge: Bu şekilde kırma çatıya benzer piramit çizilir. İletileri aşağıdaki şekildedir.

Specify first ridge end point of pyramid: Piramit tepe doğrusunu oluşturacak 1.
nokta (p5).

Specify second ridge end point of pyramid: Piramit tepe doğrusunu oluşturacak 2.
nokta (p6).

*Top: Kesilmiş şekildeki piramit çizmek için kullanılan seçenektir. Seçenek ile
birlikte aşağıdaki iletiler görülür. Bu iletide piramidin üst kısmının kotları girilir. Bu noktalar
mutlaka üç boyutlu girilmelidir.
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Şekil 5.14: Piramit modeli

Specify first corner point for top of pyramid: Tepe noktasının 1. noktası (p5).

Specify second corner point for top of pyramid: Tepe noktasının 2. noktası (p6).

Specify third corner point for top of pyramid: Tepe noktasının 3. noktası (p7).

Specify fourth corner point for top of pyramid: Tepe noktasının 4. noktası (p8).

5.3.3. Kama Çizimi (Wedge)

Köşegenlerinden dilimlenmiş kutu nesnesine benzer modeller oluşturmakta kullanılır
(Bilgi için aşağıda verilen Şekil 5.15’e bakınız).

Command: ai_wedge  (Enter)

Specify corner point of wedge: Kamanın sol alt köşesi (p1).

Specify length of wedge: Kamanın p1 noktasına göre X yönündeki uzunluğu (200).

Specify width of wedge: Kamanın p1 noktasına göre Y yönündeki genişliği (100).

Specify height of wedge: Kamanın p1 noktasına göre Z yönündeki yüksekliği (140).
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Specify rotation angle of wedge about the Z axis: Şeklin p1 noktasında Z ekseni
yönünde, X eksenine göre dönme açısı. Bilgi için aşağıda verilen Şekil 5.15’e bakınız.

Şekil 5.15: Kama modeli

5.3.4. Kubbe Çizimi (ai_Dome)

Kubbe benzeri nesnelerin yüzey modellerini oluşturmak için kullanılır (Bilgi için
aşağıda verilen Şekil 5.16’ya bakınız).

Command: ai_dome  (Enter)

Specify center point of dome: Kubbenin merkezi.

Specify radius of dome or [Diameter]: Bu iletide kubbenin Diameter ile çap, radius
ile yarıçap değeri girilir (100).

Enter number of longitudinal segments for surface of dome <16>: Kubbe
tabanından merkeze doğru bölünme aralığı.

Enter number of latitudinal segments for surface of dome <20>: Kubbenin kendi
merkezi etrafında bölünme sayısı.

Şekil 5.16: Kubbe Modeli

Aşağıda Şekil 5.17’de kubbe yüzey modelinden abajura benzer nesne modellenmiştir.
Bunun için “stretch” komutu kullanılmıştır. Siz de bu ve buna benzer modeller oluşturmak
için örnekler bulup çalışınız.
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Şekil 5.17: Kubbe modelinden oluşturulmuş abajur nesnesi

5.3.5. Küre Çizimi (Sphere)

Küre benzeri nesnelerin yüzey modellerini oluşturmak için kullanılır (Bilgi için
aşağıda verilen Şekil 5.18’e bakınız).

Command: ai_sphere  (Enter)

Specify center point of sphere: Kürenin merkezi.

Specify radius of sphere or [Diameter]: Kürenin verilen merkeze göre çapı /
yarıçapı (150).

Enter number of longitudinal segments for surface of sphere <16>: Kürenin
merkezinden merkezine bölünme sayısı.

Enter number of latitudinal segments for surface of sphere <16>: Kürenin XY
düzlemine paralel olan bölünme sayısı.

Şekil 5.18: Küre modeli
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5.3.6. Koni (Cone)

Command: ai_cone  (Enter)

Specify center point for base of cone: Koni tabanının merkez noktası.

Specify radius for base of cone or [Diameter]: Bu iletide Diameter ile koni
tabanının çapı, radius ile yarıçapı verilir (200).

Specify radius for top of cone or [Diameter] <0>: Koninin üst bölümünün (tepe
noktasının) çap ya da yarıçap değeri. Burada 0'dan farklı bir değer verilir ise koninin tepesi
verilen değer kadar açık çizilir. Bu durumda koni XY düzlemine paralel olarak kesilmiş
çizilir

Specify height of cone: Koninin yükseklik değeri (300).

Enter number of segments for surface of cone <16>: Koninin kaç bölüm / dilim
çizileceği. Buradaki 16 değeri programın varsayılan değeridir (Bilgi için aşağıda verilen
Şekil 5.19’a bakınız). Soldaki şekilde koni bilgileri, sağdakinde ise, bir çöp kutusu modeli
görülmektedir.

Şekil 5.19: Koni modeli ve modelden oluşturulmuş çöp kutusu

5.3.7. Halka / Simit Çizimi (Torus)

Halka benzeri yüzey modeller oluşturmak için kullanılır (Bilgi için aşağıda Şekil
5.20’ye bakınız).

Command: ai_torus  (Enter)

Specify center point of torus: Oluşturulacak halkanın merkezi.

Specify radius of torus or [Diameter]: Şeklin (halkanın) yarıçapı / çapı (200).

Specify radius of tube or [Diameter]: Şeklin (halkanın) kalınlığını belirleyen
çemberin yarıçapı / çapı (100). Şekilde görülen küçük çemberler.
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Enter number of segments around tube circumference <16>: Şeklin kendi çapı
etrafındaki bölünme sayısı.

Enter number of segments around torus circumference <16>: Şeklin kalınlığını
belirleyen çemberin bölünme sayısı (Bilgi için aşağıda verilen Şekil 5.20’ye bakınız).

Şekil 5.20: Halka modeli

5.3.8. Ters Kubbe Çizimi (ai_Dish)

Ters kubbe benzeri yüzey modeller oluşturmak için kullanılır (Bilgi için aşağıda
verilen Şekil 5.21’e bakınız).

Command: ai_dish  (Enter)

Specify center point of dish: Ters kubbenin merkezi.

Specify radius of dish or [Diameter]: Bu iletide kubbenin Diameter ile çap, radius
ile yarıçap değeri girilir (100).

Enter number of longitudinal segments for surface of dish <16>: Kubbe
tabanından merkeze doğru bölünme aralığı (16 varsayılan değer).

Enter number of latitudinal segments for surface of dish <20>: Kubbenin kendi
merkezi etrafında bölünme (dilim) sayısı.

Şekil 5.21: Ters kubbe modeli

5.3.9. Ağ Şeklinde Yüzey Oluşturma (ai_Mesh)

Ağ şeklinde yüzey örme komutudur. Dikdörtgen bir alanı yatay ve düşey
doğrultularda istenilen sayıda ağ şeklinde aralıklara böler. Bu bölünen ağ bir yüzey oluşturur
(Bilgi için aşağıda verilen Şekil 5.22’e bakınız).
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Command: ai_mesh  (Enter)

Specify first corner point of mesh: Dörtgen yüzeyin 1. noktası (p1).

Specify second corner point of mesh: Dörtgen yüzeyin 2. noktası (p2).

Specify third corner point of mesh: Dörtgen yüzeyin 3. noktası (p3).

Specify fourth corner point of mesh: Dörtgen yüzeyin 4. noktası (p4).

Enter mesh size in the M direction: Düşey bölme çizgisi sayısı Max=256.

Enter mesh size in the N direction: Yatay bölme çizgisi sayısı Max=256.

Şekil 5.22: Mesh Modeli

Mesh boyutlarını koordinat girerek ya da mouse ile pikleyerek girmek mümkündür.

5.3.10. 3B Modelleri Döndürme (ROTATE3D)

3B çizimlerde çok kullanılacak 3B komutlardan biri de ROTATE3D komutudur.
Komut seçilen (2B ya da 3B) nesneleri 3B olarak döndürmeye yarar. Aşağıdaki
uygulamalara benzer uygulamalarda bu komut çok kullanılır (Bilgi için aşağıda verilen Şekil
5.23’e bakınız).

Command: rotate3d  (Enter)

Select objects: 3B olarak döndürülecek nesnelerin seçimi.

Specify first point on axis or define axis by

[Object/Last/View/Xaxis/Yaxis/Zaxis/2points]: Döndürme ekseninin birinci noktası.

Komut bu iletideyken döndürme seçeneklerinden biri de seçilebilir.

Specify second point on axis: Döndürme ekseninin ikinci noktası.

Specify rotation angle or [Reference]: 90 Döndürme açısı.
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Ayrıca döndürme işleminde şu seçenekler de kullanılabilir.

Object: Bir nesneyi baz alarak döndürme işlemi yapar. Bir çizginin doğrultusu, bir
çemberin düzlemi vb. buna örnektir.

Last : Çizime son katılan nesneye göre döndürme işlemi yapar.

View: Aktif pencere düzlemine göre döndürme işlemi yapar.

Xaxis: X eksenine göre döndürme işlemi yapar.

Yaxis: Y eksenine göre döndürme işlemi yapar.

Zaxis: Z eksenine göre döndürme işlemi yapar.

Plan düzlem X eksenine göre 90 derece Y eksenine göre 90 derece

döndürülmüş

Şekil 5.23: Rotate3D uygulaması

Şekil 5.24: Zincir uygulaması

Yukarıda Şekil 5.24’te verilen zincir çizimini öğrendiğiniz ai_torus, stertch ve
raotate3d komutlarını kullanarak çizmeye çalışınız.
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5.4. Uygulamalar

Yüzey uygulamaları yaparken tel kafes ve yüzey için ayrı katmanlar oluşturunuz.
Yüzey oluşturduktan sonra diğer kenarları da seçebilmek için, geçici olarak yüzey katmanını
kapatıp, seçim yapmak daha pratik olabilir.

Yüzey hassasiyeti için SURFTAB1 ve SURFTAB2 sistem değişkenleri ile yüzey
poligon sayısını artırabilirsiniz (30- 50 arasında bir değer alınabilir).

5.4.1. 3D Face ile Kutuya Yüzey

Aşağıda Şekil 5.25’de koli şeklinde verilmiş kutuyu tel çerçeve şeklinde modelleyip,
3DFACE komutu ile yüzey kaplamalarını yapınız. Komutu uygularken noktaların girişlerini
sırasıyla olacağını unutmayınız.

a) b)

Şekil 5.25: Kutuya 3DFace uygulaması

5.4.2. Edgesurf ile Çatı Kaplama Yüzeyi

Aşağıda Şekil 5.26’da verilen kırma çatının, koyu şekilde gösterilmiş bölgesini, yüzey
ile kaplamak için EDGESURF komutunu kullanınız. Komut girildikten sonra koyu şekildeki
kenarları seçerek yüzey oluşturunuz. Belli bir sırada kenar seçme zorunluluğu yoktur.

Şekil 5.26: Çatıda Edgesurf uygulaması

5.4.3. Rulesurf ile Harita Yüzey Uygulama

Haritalarda verilmiş olan eş yükselti eğrilerinin, Şekil 5.27.c’de görüldüğü gibi kendi
yüksekliklerinde oluşturularak RULESURF komutu ile arazi yüzeyi oluşturulabilir.
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a) b)

c) d)

Şekil 5.27: Rulesurf ile harita yüzeyi modelleme

5.4.4. Tabsurf ile Merdiven Tırabzan Yüzeyi

Aşağıda şekil5-28’de verilen merdiven tırabzan kısmını oluşturmak için, merdiven
korkuluk parmaklıklarının uç noktalarını kullanarak eğri (SPLINE) oluşturun. Şekilde A ile
gösterilen tırabzan kısmını line ile çizin. Çizginin Z eksenine dik olduğuna dikkat edin.
Sonra TABSURF komutunu kullanarak, birinci iletideki seçimde eğriyi, ikinci iletideki
seçimde A ile gösterilen çizgiyi seçin.

Şekil 5.28:Tabsurf ile merdiven tırabzanı modelleme

5.4.5. Revsurf İle Fiskos Masası Modeli Oluşturma

Aşağıda Şekil 5.29’da verilen dönel eksenli nesnelere benzer modeller oluşturmak
için, önce şekilde kalın çizgilerle ifade edilmiş şablonu oluşturun. Şablonun Pline olması
gerekmektedir. Şablonun döndürüleceği, şeklide A ile belirtilmiş ekseni Line ile çiziniz.
REVSURF komutunu çalıştırınız. Birinci iletide gelecek seçim iletisinde kalın çizgi ile
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belirtilen şablonu, ikinci iletideki seçim de ise ekseni seçiniz. Üçüncü iletide döndürülme
açısı varsayılan 360 derecedir. Burayı da Enter ile geçiniz

Şekil 5.29: Revsurf ile fiskos masası modelleme

5.4.6. 3D Mesh ile Uzay Kafes Çatı Kaplama Yüzeyi

3D Mesh ile çelik çatı yüzeyinin her bir noktası doğru şekilde işaretlenerek, yüzey
kaplaması yapılır.
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UYGULAMA FAALİYETİ

UYGULAMA FAALİYET
İşlem Basamakları Öneriler

 Yukarıdaki uygulamaları yaparken belli
bir işlem sırasına göre yapınız.

 Katmanlarla çalışmayı unutmayınız.

 Nesnelerin kenar, eksen, şablon vb.
seçimlerinde dikkatli olunuz.

 Yüzeyler oluşturulduktan sonra, yüzeyin
arka planında kalan kısmı HIDE komutu
ile gizleyiz.

 Gölgeli / boyalı görünüm için
SHADEMODE komutunu kullanınız.

 Bundan önceki modüllerde anlatılan
Pline, Pedit komutlarını tekrar gözden
geçiriniz.

 Uygulamaları yaparken daha çok
klavye kısa yollarını kullanmayı tercih
ediniz.

 Uygulama örneklerindeki kutu, çatı vb.
nesnelerin bütün yüzeylerini uygun
yüzey oluşturma komutlarıyla
kaplayınız.

UYGULAMA FAALİYETİ
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ÖLÇME VE DEĞERLENDİRME
ĞERLENDİRME
A- OBJEKTİF TESTLER (ÖLÇME SORULARI)

Aşağıdaki soruların cevaplarını doğru ve yanlış olarak değerlendiriniz.

1) Tel kafes modellere yüzeyler kaplanarak gerçeğe uygun resimleri elde edilebilir.

2) 3DFACE komutu ile her türlü yüzeyi oluşturmak mümkündür.

3) Her yüzey modelin kendine özgü komutu ve oluşturma yöntemi vardır.

4) Yüzey modellerin her bir tutamağının (gripslerin) konumları değişemez, sabittir.

5) Yüzey modellere STRETCH komutu uygulanamaz.

6) Yüzey modellerde boşluklar açılamaz.

7) Yüzey modeller diğer yüzeyler ile birleştirilemezler.

8) Yüzey oluşturmada, yüzeydeki poligon sayısını belirlemek için SURFTAB1 ve

SURFTAB2 komutları kullanılır.

Cevaplarınızı cevap anahtarı ile karşılaştırınız.

DEĞERLENDİRME

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt yaşadığınız
sorularla ilgili konuları faaliyete geri dönerek tekrar inceleyiniz

Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz.

ÖLÇME VE DEĞERLENDİRME
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B- PERFORMANS TESTİ

Aşağıda hazırlanan değerlendirme ölçeğine göre, gelişmiş yüzey oluşturma ve hazır
yüzey uygulamalarını değerlendiriniz.

Gerçekleşme düzeyine göre, evet- hayır seçeneklerinden uygun olanı kutucuğa
işaretleyiniz.

KONTROL LİSTESİ

Amaç
3 Boyutlu yüzey modeller oluşturma
alışkanlığı kazanmak.

Adı soyadı

Konu 3 Boyutlu yüzeler Sınıf Nu

Değerlendirme Ölçütleri Evet Hayır

1
3Dface komutu ile tel kafes modelin istenilen yüzüne yüzey
kaplamayı öğrendiniz mi?

2
Edgesurf komutu ile dört kenarlı tel kafes modele yüzey
kaplamayı öğrendiniz mi?

3
Rulesurf komutu ile tel kafes modelin iki kenarını seçerek
yüzey kaplamayı öğrendiniz mi?

4 Tabsurf komutu ile yüzey kaplamayı öğrendiniz mi?

5
Rulesurf komutu ile eksenel yüzey modeller oluşturmayı
öğrendiniz mi?

6 3Dmesh ile yüzey kaplamayı öğrendiniz mi?

7 Hazır yüzey modelleri oluşturmayı öğrendiniz mi?

8 Hazır yüzey modeller ile model oluşturmayı öğrendiniz mi?

9 3B modeli döndürmeyi öğrediniz mi?

10
Yüzey modelleri deforme ederek başka formda yüzey
modeller oluştumayı öğrendiniz mi?

11
Yüzey modellerin poligon sayısını değiştirmeyi öğrendiniz
mi?

Toplam Evet ve Hayır cevap sayıları

DEĞERLENDİRME

Bu değerlendirme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek
eksiklerinizi tamamlayınız.
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MODÜL DEĞERLENDİRME
PERFORMANS TESTİ (YETERLİK ÖLÇME)

Modül ile kazandığınız yeterliği aşağıdaki kriterlere göre değerlendiriniz.

PERFORMANS TESTİ

Değerlendirme Ölçütleri Evet Hayır

3 Boyutlu koordinat sistemi
A) 3 boyutlu koordinat sistemini kavradınız mı?
B) UCS koordinat sistemini kavrayıp uyguladınız mı?

3 Boyutlu görüş pencereleri ve etkileşimli izleme
A)Çalışma ekranınızı pencerelere bölerek uygulama yaptınız mı?
B)Modelinizin ana görünüşlerini elde ettiniz mi?
C)Modelinizi Orbit aracıyla görüntülediniz mi?

3 Boyutlu model gölgelendirme
A)Modellerinizi boyalı / gölgeli görüntülediniz mi?
B)Görsel yardımcıları doğru kullandınız mı?

Çizgiler ve Filtreler
A)Tel kafes şeklinde modelleme yaptınız mı?
B)Koordinat girişlerinde filtreleri doğru kullandınız mı?

3 Boyutlu Yüzeyler
A)İleri düzey kaplama tekniklerini öğrenip uyguladınız mı?
B)Hazır yüzey modelleri kullandınız mı?
C)Hazır yüzey modellere düzenleme yaptınız mı?

Toplam Evet ve Hayır Cevap Sayıları

DEĞERLENDİRME

Yaptığınız değerlendirme sonucunda eksikleriniz varsa öğrenme faaliyetlerini
tekrarlayınız. Kendinizi yeterli görüyorsanız bir sonraki modüle geçmek için öğretmeninize
başvurunuz

Modülü tamamladınız, tebrik ederiz. Öğretmeninizle iletişime geçiniz.

MODÜL DEĞERLENDİRME
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CEVAP ANAHTARLARI

ÖĞRENME FAALİYETİ- 1 CEVAP ANAHTARI

1 D
2 Y
3 Y
4 D
5 D
6 Y
7 D
8 D
9 Y

10 Y

ÖĞRENME FAALİYETİ- 2 CEVAP ANAHTARI

1 Y
2 D
3 Y
4 D
5 D
6 Y
7 D
8 Y

ÖĞRENME FAALİYETİ -3 CEVAP ANAHTARI

1 Y
2 D
3 Y
4 D
5 D

CEVAP ANAHTARLARI
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ÖĞRENME FAALİYETİ -4 CEVAP ANAHTARI

1 Y

2 D

3 D

4 Y
5 Y
6 D
7 Y

ÖĞRENME FAALİYETİ- 5 CEVAP ANAHTARI

1 D
2 Y
3 D
4 Y
5 Y
6 D
7 Y
8 D

Cevaplarınızı cevap anahtarları ile karşılaştırarak kendinizi değerlendiriniz.
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